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GETTING



Part 1

GETTING
STARTED

Scan this QR Code to watch 
our Getting Started video!



LOG INTO YOUR ACCOUNT

ENTOURAGE SITE:

In the upper right-hand corner, click LOGIN, then enter your 
User ID and Password.

***User IDs and Passwords for the Primary 
Contact are emailed within 24 hours of 
signing, please contact your Account 
Manager if you did not receive an email.

Next, out of the Project List that appears, 
click OPEN next to your current 
yearbook project.

www.entourageyearbooks.com
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YOUR YEARBOOK HOMEPAGE:
The three large buttons, Upload Photos,View Deadlines, and Design Pages, are the main tools used to create a yearbook. 
These buttons provide quick access to these core features.

ACTIVITY NEWSFEED:  Keep track of your account activity. The newsfeed 
feature displays various updates and activity in your account (i.e. photo 
uploads, Entourage announcements, and more).

The Manage tab 
allows you to edit 
your book specs and 
account information, 
setup your staff and 
their permissions, 
access your 
yearbook ladder and 
any content that has 
been uploaded.

The Upload tab 
provides quick access 
to the Upload Photo 
and other upload 
features, such as 
uploading PDFs and 
videos.

The Collaborate tab 
allows you access to 
Explore, Share, 
Discuss, and Learn. 
These sections include 
our Template library, the 
Yearbook Contest, 
Certification tests, etc.

The Design tab 
gives you design 
access to the 
different parts of 
your yearbook such 
as the cover, index, 
and general pages, 
as well as your 
People Pages. You 
can also request a 
Design Review from 
this menu.

The Request tab 
gives you the option 
to request a Proof 
Book, Marketing 
Materials, and/or a 
Yearbook Kit.

The Help tab is your 
key to contacting 
Entourage with any 
questions you may 
have. There are online 
tools to help you right 
away. You can also 
sign up for  our free 
online training 
sessions via our 
webinar calendar.

Getting Started
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Accessing Your AccountMANAGE ACCOUNT Getting Started

ACCOUNT INFORMATION:
Here you can update your contact information, page count, book 
quantity, and even your delivery date. 

In the Manage Account section you can find your Account Manager,
Sales Rep, and the Billing Departments direct contact information. They are at 
your service for any assistance you may need throughout the yearbook process.

If you create more than one 
yearbook with our software, 
we offer cloning of one 
project to another using the 
IMPORT ACCOUNT CONTENT 
button.

6



MANAGE YOUR TEAM:

ADD STAFF MEMBERS

The Manage USERS page is where you can add each member of your team by creating them new login information, or invite 
staff members from previous projects to keep the login information they already use.

Create your new team 
member logins here!

The 3 STAFF MEMBER TYPES:

1. ADMIN - Recommended for the Primary 
Contact and those who need full design and 
account/invoice access.

2. EDITOR - Recommended for students and those 
who require access to the designer and the 
Collaborate tab.

3. USER - Recommended for those who need only 
limited access to the website, such as Manage 
and Upload Photos.

These types can be customized via the Manage 
Permissions page.

Scan this QR Code to watch 
our How To Add A User to 

your Project video.
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UPLOAD AND MANAGE PHOTOS

ORGANIZE YOUR PHOTOS:
Utilize the Manage Photos page to organize your library of photos before or as you upload.  This page is 
integrated with Instagram, Facebook, Google Drive, Dropbox, our own Mobile App, and email submission.

To begin, create your photo categories by clicking on the Upload New Photos

button, then Create Photo Category. You can also designate an existing 
category as a Parent category when creating a new category to make a 
folder within a folder.

Once your category is selected, click on the Upload New Photo button.  To 
upload photos from your files, click Browse and navigate to the photo file(s) 
on your computer.

Each category that you create will be automatically assigned an email address. 
The list of addresses can be found in the Email Photos button. 

Provide parents, teachers, and other members of the school community with 
the corresponding email address(es). Any attached or embedded photos will 
automatically upload to that specific category once the email is sent.

Scan this QR code 
to watch our video 
on How to Manage 
Photos

Scan this QR code to 
watch our video on How 
to Upload Photos.
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UPLOAD AND MANAGE PHOTOS Getting Started

Upload PDFs to the Website

Re-signed accounts have the ability to Import Previous Year Photos. You will 
be able to choose an old category and import it with the pictures to your 
new account.

Log into your social media to use photos from your 
Instagram, Facebook, Google Drive, and Dropbox 
accounts.

If you have any PDF files you need to upload to the project, you can do so in the Manage 
Uploads section. 

You can view any PDFs that 
have been previously uploaded 
to the account here.

Click the Upload File button. You can 
then select any cover or page design 
PDFs you created  in an outside program 
like Illustrator, Photoshop, or InDesign. 
Designate the content type and any 
appropriate comments, then click 
Upload File button to complete the 
process.
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MANAGE LINK Getting Started

LiNK is a separate website that serves as a "link" between your project and the the school 
community. Manage LiNK allows you to activate online yearbook and ad sales, photo 
submission on the desktop and mobile app, view the eYearbook, and create hosted Link pages 
and polls.

Check the boxes to 
activate the items that 
you would like to make 
available to LINK users. 
Click Confirm LiNK 
Changes to update.

This is how the LiNK home page 
appears. Users will be required 
to create their own login 
(separate from your staff 
logins) and will search by your 
yearbook account title.

The LiNK Site:    link.entourageyearbooks.com

Purchase, Upload, and Design 
buttons will only be available 
once the corresponding setting is 
turned on in Manage LiNK.

See page 42 for more about the LINK site!10



MANAGE DEADLINES/INVOICES
In Manage Deadlines, you will find several key submission dates based on your current delivery 
date. If you choose to change your delivery date, these dates will adjust automatically. Contact 
your account manager if you have concerns about these dates.

The First, Second, and 
Third Submission dates 
are also proof book 
request deadlines. 
See page 15 for more 
about the Request 
Proof Book feature.

Pay Invoices Online Anytime! You have the ability to pay 
your invoice anytime 
before your Final Approval 
date by going to the 
Manage Invoices section.

Click Pay Now to submit 
credit card information or 
click Download to receive a 
printable PDF file to forward 
to your financial secretary.
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HOMEPAGE TOOLBAR

Log into your Facebook profile and access your photos to use in your 
yearbook. School Facebook pages are not accessible by this feature.

Aside from uploading PDF files, you have the ability to Upload 
Other Content such as .mov, .mp4, .csv, and .txt files. (Videos 
can be incorporated into the yearbook using QR codes.)

If you happen to have a file too large to upload 
directly from your computer, Entourage also has a  
Hightail feature.

* Make sure you contact your Account Manager and 
let them know you have uploaded via Hightail so they 
can make sure that the file is ready for you to place.

The Upload tab provides quick access to the Upload Photo and other upload features, such as 
uploading PDFs and videos.
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The Design tab gives you design access to the different parts of your yearbook such as the cover, index, 
and general pages, as well as your People Pages. You can also request a Design Review from this menu.

Page Design: Choose a 
page to design from 
the ladder preview on 
the left side of the 
screen. You can then 
use the tools to design 
your pages.

Design Cover:
Create your cover, 
add spine text, and set 
an exciting theme for 
your yearbook.

Design People Pages:
In this section you can create student 
portrait pages in three steps. 
- Upload your portraits and student data. 
- Separate the students by class, grade, or 
teacher, then choose a template.
- Automatically flow all of your student 
portraits onto specified yearbook pages. 

Getting Started
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HOMEPAGE TOOLBAR Getting Started

The Collaborate tab allows you access to Explore, Share, Discuss, and Learn. These sections include 
our Template library, the Yearbook Contest, Certification tests, etc.

Browse Templates: Search through hundreds of topquality templates. Get ideas for your book and 
bookmark any template you like for quick access in the designer. You can bookmark the templates 
by checking the boxes under the template preview.

You can rate 
all of the 
templates on 
the website 
and search for 
the most 
popular ideas!

Yearbook Gallery: 
Need some 
inspiration? View 
hundreds of ideas 
from other schools 
across the country. 
Use the tabs to 
switch between 
several school 
types for age 
appropriate styles.
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HOMEPAGE TOOLBAR Getting Started

The Request tab gives you the option to request a Proof Book, Marketing Materials, and/or a Yearbook Kit.

Resource Kits are materials that you can utilize to help 
guide you in your yearbook process. You can get a 
physical or PDF version of these resources.

Marketing Materials allow you to design and receive your own 
order forms and posters. Promote your yearbook sales and 
generate interest in the yearbook. This is also a way to share 
information about buying books and ads online as well as how 
to contribute photos. 

In order to request these features it is required to have  
a minimum of 3 design points.

Contact your Account Manager to inquire further 
about the design points.

Proof Books are physical copies of your yearbook that 
can be used to check for clarity of images, layout, 
and spelling/grammar. Click Add to Cart below the 
first available proof book choice, fill out the delivery 
information, and click Confirm.

Proof books take 1 week plus shipping to arrive, so 
please order at least two weeks before final approval.

HOMEPAGE TOOLBAR

A ladder poster is also available with the Resource Kit.
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HOMEPAGE TOOLBAR
The Help tab is your key to contacting Entourage with any questions you may have. There are online tools to help you right away. You 
can also sign up for our free online training sessions via our webinar calendar.

Explore the Help Site for answers to 
frequently asked questions, chat in a 
yearbook forum with other advisors across 
the country, and view the Entourage 
newsfeed for recent updates and 
announcements.

The Contact Supportpage contains live chat and contact 
information for technical support and the billing department.

Schedule a Webinar for yourself or your class under the 
Webinar Training Sign-up page. There are three main 
training sessions to choose from:

1. Getting Started/ Entourage Website

2. Edonline Basics

3. People Pages

16



YEARBOOK LADDER
YOUR PAGE PLANNING HQ:

View your yearbook progress, assign pages to staff, designate page content, directly access pages to design, and more.

Page Numbering: 
Add page numbers 
to your yearbook 
pages. Simple and 
advanced options 
are available.

Spell Check Book: 
Review potential 
spelling errors page-
by-page. The 
feature will make 
approved 
corrections to your 
page(s) 
automatically.

Submit for 
Production: When 
you are ready to 
submit your book for 
production, this 
button will take you 
to the approval 
form.

Preview Yearbook: 
View the digital 
flipbook of your 
yearbook progress. 
You can also 
generate a PDF 
version of your book 
sent to an email 
address of your 
choice.

In these boxes you can assign pages to 
members on your team. You can also lock 
certain pages once they are complete to 
prevent further editing from non-admin 
staff members.

Preview/Approve 
Cover: Check 
several previews of 
your cover design 
and approve it 
when you are 
ready. Note: 
approving the 
cover will lock the it 
from any further 
editing.

You can access your designer by clicking on the Design Page button next 
to the corresponding page you would like to access.

Getting Started

Scan this QR Code to 
watch our All About 
Your Yearbook 
Ladder video.
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MANAGE YEARBOOK SALES 

ONLINE STORE SETTINGS:
In the Manage Yearbook Sales section, set pricing, sales deadlines, and track sales progress.

In the blue boxed area, you 
can reference quantities sold 
and generated revenue to 
order an accurate number of 
books to be printed.

Setup Online Sales:
Activate your online store and set parameters, such as 
yearbook cost, optional tiered pricing, sales deadlines, 
required customer information, etc.

Personalized yearbooks are available as a sales option. This 
involves foil stamping the name of the student onto the front 
book cover.

Scan this QR Code to 
watch our How to Turn On 

Online Yearbook Sales
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MANAGE YEARBOOK SALES 

ONLINE STORE SETTINGS:
In the Manage Yearbook Sales section, set pricing, sales deadlines, and track sales progress.

Track Yearbook Sales records every online and offline sale made through your store. Information will include date of 
purchase, total amount paid, intended recipient, quantity ordered, and personalization text if applicable. Spreadsheet 
downloads are also available.

If you offer in-school sales, 
select Create New In-
School Sales Entry to 
record each sale. Please 
note that personalizations 
not purchased in the 
online store will only be 
produced if added 
through this feature.

MANAGE ONLINE AD SALES:

Setup Ad Pricing: Configure your pricing and 
add size options for family members and 
businesses to purchase.

Track Ad Sales: View and approve design 
and purchase ads before they can be 
placed in the page designer.

Getting Started

Scan this QR Code to 
watch our How to

Turn On Online 
Ad Sales video.
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APPROVE FOR PRODUCTION
FINAL APPROVAL FORM:
Navigate to the final approval form from the Manage tab, the Yearbook Ladder, or Manage Deadlines 
page. This will bring you to the 6 step Approval Form.

You can watch the video in the Overview section and it will give you a step by step video tour 
on how to approve for production using this form.

Approve Cover: 
If you have not already done so, 
review the variety of  previews of 
your cover design andApprove 
it at the bottom of the page.

Step 1: Approve the Cover Content

Approve Book Content: 
- This if the final chance to activate page 

numbering, if desired.
- Run the people page check to verify all 
uploaded people in your index have been flown.
- Verify that all ads have been placed, even if 
there are 0 purchased ads.
- This is the final review of all of your pages and 
pre-flight warnings. Click on the provided 
warning links to go directly to the affected page 
in the designer and make any necessary fixes. 
- Fill out the bottom portion and click Approve.

Step 2: Check Book Content

20



APPROVE FOR PRODUCTION

Step 2: Check Book Content

Set Delivery Information
Provide the name and delivery address 
for your order.

Note: PO Boxes are not valid shipping 
addresses.

You have the ability to choose a faster 
turnaround time but there will be a rush 
fee associated with the date 
(approximates shown).

The standard turnaround for yearbooks is 28 days. 

Step 5: Digital Yearbooks and Autographs

Getting Started

Step 3: Delivery Information

Step 4: Make Final Payment

In this section you will be able to confirm 
the total number of books being ordered.

You will then be able to pay your final 
balance for the yearbook order.

If you had your online store turned on, you can apply the funds raised online to your final balance.

In this section you can turn on the e-yearbooks or set a price for 
parents who would like to purchase a virtual book they can view 
from their phones. 

They can even create autographs virtually, as well!

Step 6: Final Approval

This is the final step to approve your book for production.  Here 
you will confirm your specs for your order.

If you want to sell the books after you approve,  you can turn on 
post approval sales.  Fill out the rest of the page and then click 
Approve For Production. 21





EDONLINE
DESIGNER

Part 2

Scan this QR Code to watch a 
video on How to Build A Page in 
the EDO Designer.



ACCESS THE DESIGNER

Access the designer using the Design tab or Manage Ladder. Only one person can access a spread at one time. Entourage 
recommends using Google Chrome or Mozilla Firefox as your browser while you design your pages.

Note: Once we receive your initial deposit, your software will be fully activated. Until 
then, design access is limited to the first 7 pages and the cover.

Click the gray X

to hide the Select 
Page side menu 
for pages and 
return to the left 
toolbar.

WHEN IN EDONLINE:
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ACCESS THE DESIGNER

Welcome to the designer! On the left side of the page is the Select Page menu. Select a spread to open the pages and begin 
your design.

EDONLINE PAGE GUIDES

While in the designer, these colored lines on the 
canvas will guide the placement of your content:

Red 
Guideline
This is the 
bleedline. All 
backgrounds 
should meet or 
exceed this line 
completely to 
ensure a clean 
bleed off the 
page.

Black 
Guideline
This is the trim line, 
where the pages 
will be cut during 
production. This 
designates the 
actual page 
edge in the final 
product.

Black Center 
Line
This is the center of 
your spread, 
where the pages 
will be bound to 
the cover. Make 
sure text or faces 
in pictures are not 
in this area.

Purple 
Guideline
This is your margin 
or "safe zone". Any 
items you do not 
want to get cut off 
must stay within the 
purple guidelines.

Click the red X button at the top right of your page in order to close the designer and 
return to your Ladder.

EDOnline Designer

Scan this QR Code to watch our 
Page Guidelines Inside EDOnline 
video.
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THE DESIGNER TOOLBARS

SAVE
Click this button to 
save your changes.

TOP AND LEFT TOOLBARS:

Copy 
Frame​

Paste 
Frame​

Undo

Redo

Fill
Color

Border
Color

Border
Width

Delete
Frame

Lock
Frame

Move to 
Front/
Back

Rotate

Insert Text

Preview Mode

Insert PDF

Insert Photo

Insert QR Code

Insert Template

Insert Background

Insert Approved Ads

Insert Shape

Page Builder

Move Pages

Layers

Auto Grid

Recover Pages

Elements

The LAYERS section is where to control the visibility of layers on the page, 
including unchecking the "content layer" so you are just in the "background" 
section of the page.
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THE DESIGNER TOOLBARS

VIEW TAB

PAGE TAB

FRAME TAB

PEOPLE TAB

SETTINGS TAB

HELP TAB

In the View Tab, check the box next to the feature you would like to activate. 
With the Ruler, measure the dimensions in inches and distance of objects to the 
page edge. The Snap To feature will display a green line when an object edge 
aligns with the edge of another object while being moved. The Grid feature will 
overlay a transparent graph onto your page.

The Page Tab offers the options to mirror a page layout or clear 
a page when you want to start over from scratch.

The Frame Tab provides quick access to frame settings such as add drop 
shadows to an object, add rounded corners to a selected object, or apply 
wrap text to an image so that text wraps around its edges.

In the People Tab, you can manage your people pages. You can 
also access the index generator.

In the Settings Tab you can manage page locks that are created 
by your staff members. This is useful when a staff member does 
not properly close a spread. Deleting the page lock will allow 
other members to access the spread.

The Help Tab is another way to access Entourage 
support documents and contact technical support.

EDOnline Designer
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ADD PHOTOS TO PAGES

Place Photos: 
Click on the Insert Photo button in the Insert Items section of the left toolbar. Select from your 
photo categories, then click on your desired photo and it will highlight in green. 

After you select the photo, 
click anywhere on the page 
canvas and it will appear!

If you have inserted a template, there will be Drop 
Photo boxes. After you select a photo, click inside 
a Drop Photo box and it will appear.

If a placed photo does not fit properly, you can 
adjust it by using the Photo Settings tab on the 
right hand side of the designer.
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ADD PHOTOS TO PAGES

Add a PDF

DROP PHOTO BOXES: You can insert these placeholder boxes 
as well!

These are useful at the beginning of your project if you want to 
design a page without having photos available for that page.

EDOnline Designer

Once you upload a PDF under Manage Uploads, you can place it on the page 
by clicking the Insert PDF button on the left toolbar.

Scan this QR Code to 
watch our How to 
Insert and Edit Photos 
video.
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CLIP PHOTOS

When a photo is selected on the page, a photo edit toolbar 
will appear under the top toolbar. In this toolbar, select Clip 
to remove the background from an image.

Foreground 
Brush

Background
Brush

Erase
Marks

Scalpel

Zoom
In

Zoom
Out

Zoom to 
Fit

Save 
Edits

Mark as 
Done and Exit 
Clipping Editor

You are given 500 clipping credits at the start of your project.Each time you click Done you spend a point, so please use the 
clipping feature wisely. If you run out of clipping credits, or do not seem to have any, contact your account manager and they 
will be able to assist you in getting more!

Use Foreground Brush for everything you want to keep in the photo. Use the 
Background Brush for anything you want to get rid off on the photo.

Scan this QR Code 
to watch our How 
to Use Clipping 
Tool video.
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ADD TEXT

Place Text: 
Select the Insert Text button in the Insert Items section of the left toolbar. Click on a default 
style and click onto the page to insert the text box.

Once the text is placed on the spread, and the text box is selected, a text editing toolbar 
will appear under the top toolbar. See more details on the next page.

You can also Save as New Text Style so that you can re-use your text settings later 
without the need to reformat your text each time you place a new text box.

EDOnline Designer

31



EDIT TEXT

Once in the designer click the "text" button to select a default text setting and place it on 
the page. Once on the page you will be able to edit the text box you placed.

Select
Font

Font
Size

Font
Color

Choose from our selection of various fonts and styles that will fit your yearbook page or theme. "Busy" 
fonts, such as Boogie Nights, are recommended for headlines only.

EDOnline Designer

Scan this QR 
Code to watch 
our video of How 
to Edit Text.
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Once you place a text box on the page if you want to change 
the text style, font color, or alignment there is a "Quick Menu" you 
can use. You will see the quick menu once you select a text box 
on the page.

You have the ability to "save a text style" so that you can use a 
font quicker and easier when you want to place text on the page. 

Once you select a font, font size, and color you can save it so that  
it is saved amongst the default text selections. This way if you 
have certain styles you want to use through yoru book you can 
choose them a lot easier going forward when you click on the 
"text" button.



ADD BACKGROUNDS & ELEMENTS

To add backgrounds, click the Insert Background button on the left toolbar. Select a 
category or search for a specific background type using the keyword search button. Click 
on the desired background and click onto the page to insert it. Some backgrounds are 
intended for placement on one page and others will cover an entire spread.

Add Elements  (formerly Clip 
Art) to add to the theme of 
your page. There are plenty of 
different themes and 
categories to choose from to 
fit your idea. Use the keyword 
search bar or browse through 
the categories.

In order to edit the background you must be in Background Layer mode, found in the Actions 
section on the left toolbar. In this mode, you will be able to select or edit your background layer. 

33

You can now click on a color 
to filter the element you are 
trying to find.

Click "View More" to see more  
options in the category for 
Elements and Backgrounds



ENTOURAGE EDGE
The days of not being able to find the clipart or background you want are over!  Entourage EDGE provides added 
resources you can use to customize and complete your yearbook project.

When in the 
designer 
searching for a 
element to use, 
scroll to the 
bottom and click 
"I NEED 
SOMETHING 
DIFFERENT".

Next, go to our new website Entourage Edge to request new clipart, templates, backgrounds, and more 
by pressing the blue button "Click Here!"

Once the site 
is open, you 
will need to 
" r e g i s t e r "  
and create a 
login in order 
to use the 
site.

You will not be able to login using your Entourage 
login. You will still be rewuired to register if it is 
your first time using Edge.
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EDOnline Features

Once you have lregistered with Entourage Edge, you 
can then link your yearbook project with Entourage 
Edge. 

To do so, first click "LINK ACCOUNT"  under your profile. 

Once you see this 
screen, click on the 
"LINK ACCOUNT" 
button.

You then will have to put in your Yearbook project login 
so that your yearbook is now linked with Entourage Edge.

Once you do this you can now request clipart, 
backgrounds, and templates for your project.
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ENTOURAGE EDGE
You are now ready to choose or request designs you would like to use in your project!

At the top of the screen there are options for different 
content types, and you can select a category that best 
matches what you are looking for.

The next screen with then allow you to select a specific 
design you want to use. You can search or redirect to 
another category to see the wide range of clipart/
elements you can find in your Entourage site. 

You will also be able to find art that has been requested 
from other schools.

Once you have selected 
the item you want, you 
can then select "Install to 
Entourage". 

Once you press this 
button, you will then be 
able to see your project, 
and can confirm the 
location of where you 
want the design to be 
installed.
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EDOnline Features

If you would like to request a certain clipart or background not found in the site,  just click on the "Submit Commission" button.

On this page you can put the title of the commission work you want to be made. You can also type a description  
of what you are looking to have done. So, if it is a template you will have to specify the page size and whether you 
want a single page or spread.

You will also be able to choose when you need the design by and then you can click the "Submit Request" Button 
once your form is filled out.

37
Once submitted, you will receive a notification on the Edge Homepage in the "bell" symbol at the top of 
the page.



INSERT TEMPLATES
Choose from a multitude of templates we have to offer under our Templates section.  
These pre-designed pages can give you a great starting point to build from and save your 
valuable time.

If there is content on the page when you insert a template, you will be prompted to replace or cover that existing content.

You have the ability to save your own pages as templates for later use. To Save as a 
Template, select the green down arrow next to the Save button.

You will have the option to save just a single page 
or the spread. Custom saved templates are not 
visible to other accounts but can be accessed by 
your staff in the Templates button > My Templates 
button > Templates folder.

EDOnline Designer

Scan this QR 
Code to watch 
our Using 
templates, 
Clipart, and 
Background  
video.
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MOVE PAGES & RECOVER PAGES

RECOVER PAGES

If you need to rearrange your pages, you can do so under the Move Pages button in 
the actions section of the left toolbar.

The pop-up window that appears 
will allow you to click and drag 
spreads into a new order.

Click Commit Page Moves to save 
the changes or use Reset Page 
Moves to start over.

If you would like to move single 
pages at a time, click the 
Advanced  Page Moves button 
at the bottom right of the move 
pages pop-up window.

You may bump some pages  into 
the unused page dock at the 
bottom of the screen. In order to 
save your changes, the dock at 
the bottom of the screen must be 
empty. You can drag and drop 
important pages back into the 
correct place in your book, or 
delete the blank or unneeded 
pages.

If you want to revert to a previous version of a spread, click on Recover Pages in the Actions 
section of the left toolbar.

You can choose between the 
last ten saves of the spread.

Scan this QR 
Code to watch 
our video How to 
Move Pages.

Scan this QR Code to 
watch our How to Recover 
Lost Page Content video.
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PAGE BUILDER

Use Page Builder to place multiple photos in a template of your choice onto a blank 
page. Find this feature in the Actions section of the left toolbar.

This time-saving tool works in three quick steps:

Once you click on the Page Builder Icon a side menu will appear.

Step 1: Add Photos
Click on the Select New Photos button and 
your categories list will open. Choose the 
photos you want on the page. The selected 
photos will have a green border. Then click 
Add Selected Photos when you are finished 
with your selection.

Step 2: Choose Template
Click Choose Template to browse for 
your desired template. You may sort 
by category or by photo count, 
which will display templates that 
have the same quantity of photo 
spots available as selected in step 
one. Click Use Selected Template 
when your final choice is highlighted 
green.
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Step 3: Create Page
Click Create Page to view the generated template that Page Builder creates. You have the option to click 
Regenerate Preview so the photos shuffle around on your template or place the design on the left page or 
the right page once you are satisfied with the layout.

Once the template is placed on the page, you can adjust the photo within the photo frames using the Photo Settings tab 
on the right side of the designer. See page 38 for more details.

EDOnline Designer
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ADVANCED MENU
The Advanced Menu tabs give you more options to adjust and edit objects on the page. Click one of the tabs on the 
right side of the designer to expand those options.You must have a photo or text box selected to view the options within 
those tabs.

There are three Advanced Menu tabs: Photo Settings, Text Settings, and Frame Settings.

To easily close any of the Advanced Settings tabs, click the Advanced Menu button on the bottom of the designer.

Clear Image - Deletes the image, leaving the 
selected frame available for a new image.

Flip - Horizontally or vertically flip the image.

Fit - Gives several fitting options for the image. Use 
Manual to move the image within the frame without 
altering the frame size or shape.

The settings below the image preview allow you to 
change the image's position on the page, 
dimensions, rotation, and size within the frame.

Photo Settings
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Various border, color, and fill options can be found here. The 
Inset options customize the margins between the text and frame.

In addition to the Font, Size, and Color options 
found in the Quick Menu, this feature provides 
Baseline, Case, Tracking, Kerning, and Leading 
for more advanced text formatting.

Text Settings

This tab is most frequently used to add or lower the opacity of an image 
so that it appears lighter than usual. The lower the percentage, the 
more transparent the image will become.

EDOnline Designer

Frame Settings
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NEW IN EDONLINE

90s RETRO THEME NOW AVAILABLE!
After popular demand we have now added "90s Retro" backgrounds, templates, and clipart. If you have 
suggestions for themes you would like to see in the future, please let us know!

Backgrounds!

Templates!: Explore our new "Start Your Project" templates.
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EDOnline Designer

C
lip

ar
t!

New "Centric" backgrounds now availble for use!
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THE LiNK SITE
Provide LINK.ENTOURAGEYEARBOOKS.COM to community users like parents, teachers, or friends. Here they 
can  Upload Photos, Purchase Yearbooks, and Design Ads for your project.

Once on the site, they must Register with their 
own User ID and password to access the LiNK 
site. From there, they can search for the 
school's yearbook by name and use the 
features you have activated on your Manage 
LiNK section.

Use the Purchase Books button when ready to purchase a yearbook online. Follow the 
prompts for your order and check out before the deadline. Provide your email address to 
receive an electronic receipt.

The Design Yearbook Ad button will bring you to a list of available ad sizes and prices for 
purchase in your school yearbook. These can be used for personal pages for students or 
business advertisements. 

Scan this QR Code to watch 
our How to Purchase a 
Yearbook in the LiNK Store 
video.
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Click Upload Photos to view 
the available categories for 
submission. Select the 
desired category from the 
dropdown menu then click 
Browse. Choose photos 
and click Open to begin the 
upload.

If you need more Design Points to request a Proof Book or 
Marketing, you can purchase more points here in LiNK. Just click 
the Purchase Design Points button!

DOWNLOAD THE MOBILE APP

With the mobile app, LiNK users have the ability to upload 
photos to your categories directly from their phones. Make 
sure you are registered in the LiNK site first in order to log into 
the mobile app. 

*Make sure permission for the mobile app is turned on under 
the Manage LiNK section of your yearbook account.

LINK SITE & Mobile App!

Scan this QR 
Code to watch 
our How to Use 
LiNK to Upload 
Photos video.

Scan this QR Code to 
watch our How to Turn 
on Photo Uploading for 
the LiNK Mobile App 
and Website video.
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PEOPLE



Part 3

PEOPLE
PAGES

Scan this QR Code to watch our 
training video  Flow Student 

Portraits!



MANAGE PEOPLE DATA

DOWNLOAD YOUR PORTRAITS:
You will first need to download your portraits to your computer desktop before uploading them into your 
yearbook project. Your photographer should provide you with the files in PSPA format via a physical CD disc or 
via a digital download link. 

Next, use the drop-down menu below Select Photo Category to 
confirm into which existing photo category the portraits should be 
uploaded.

Then, select your Matching Index. The photos in your designated 
category will  sync with the information in this specific index.

If you have not yet uploaded your Index, you can upload it along 
with the portraits in the next step. 

Navigate to the Manage People Data page available from the Manage drop-down menu in your account 
toolbar.  This screen allows you to upload and manage all of your people portraits and data in one location.

Download the portraits 
and index files  from your 
photographer's online 
portal or email 
attachment.  You may 
receive compressed files 
that you must "unzip" 
before uploading into the 
yearbook project.

Insert the CD into a 
disc reader and 
copy the files from 
the disc onto your 
computer desktop.  
You may receive 
compressed files that 
you must "unzip" 
before uploading 
into the yearbook 
project.

DIGITAL LINK CD

UPLOADING YOUR PORTRAITS AND MATCHING INDEX:

To get started, click on the blue button ​ Click here to Upload Photos and Student Index.​
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MANAGE PEOPLE DATA UPLOADING PORTRAITS

Now, select files to upload. You may either drag and drop files onto the cloud 
icon from an open file window, or you may select the orange Browse button to 
navigate your file explorer and select which files on your computer to upload. 

Once the index successfully uploads, a popup window 
will appear that displays the data in a spreadsheet. Using 
the drop-down menus above each column, confirm 
which columns contain First Name, Last Name,  Photo File 
Name, Grade, Class, and Teacher's Name, if applicable. 
You may have columns you do not need. Once your 
column headers are set, click the green Confirm button 
to allow the photos to sync with the data.

Click on a  portrait for 
editing options. You 
can correct spelling, 
change the grade or 
class, or change their 
photo. Select the blue 
Save button to keep 
your changes. 

Change Portrait Photo
Delete Person from Project

After syncing, you should see all of your People Page Portraits displayed as shown below.

If you need to add a 
person that was not 
included in the index, 
select the Add New Person 
button to properly add 
students that are missing. 
You will manually type 
their information and 
assign a photo in the edit 
person details window, 
shown left. 
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FLOWING PORTRAITS
Once you have finished uploading your portraits and data, it is time to begin placing people onto your yearbook pages. 
Open the pages in your yearbook project by selecting Page Design from the Design drop-down menu in the main account 
dashboard, and select your desired pages to design using the left scrollbar. Next, select the People drop-down menu in 
the top toolbar of the page designer, and select the option Make People Pages to open the People page window. 

You should now see the Let's Get Started 
People Pages Menu. At this point you have 
already uploaded your portraits and index file 
and are ready for Step 2. Select the template 
you would like to use for your yearbook by 
going to the second tab labeled Templates. 

Click on a template to select it. The selected 
template will  highlight in blue, and a larger 
preview will appear in the right panel.

Once you have the desired template 
selected, use the blue buttons in the 
bottom right corner to: Build Template on 
Left, Build Template on Right, or Build 
Template on Both Pages.

Once your template has been built on your page, you will be prompted to Build More Templates or Continue to Flow. Select 
Continue to Flow if you are ready to flow your portraits onto your pages. 

Tip: Quickly find the template 
that best fits your needs by 
using the filters to narrow down 
your choices. Filter by Template 
Type, People Per Page, Teacher 
Field, and Rounded Corners.
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FLOWING PORTRAITS FLOWING PORTRAITS

Repeat these steps to flow the rest of your 
groups. The groups that have  flowed fully 
into the yearbook will  highlight in green.

Depending on your group size and internet speed, it may take up to a minute for the system to flow your 
portraits onto the page.  Pictures will automatically flow in alphabetical order, and will fill the frames in the 
template until the template is full, or until there are no students remaining in the group, whichever comes first.

Choose the group sorting method you prefer  to separate your students 
into groups using the first drop-down menu. Depending on the data 
included in your index, and which columns you confirmed when 
uploading, your options will be Class, Teacher, Grade, or ALL. 

After selecting the group sorting method, select 
the Group Name from the left list to highlight 
blue and display a preview of the group's 
students on the right-hand side.

Once you are ready to flow your group, select 
Flow Left Page or

Flow Right Page  on the bottom right to 
populate the students into the built template 
using your designated settings.

Customize the template flow settings in the top right to select your

No Photo Icon, whether to Sort People By First Name or Last Name, 
and whether to Split Name on multiple lines.

If you have more people that need to be 
flown, select the People tab from the top 
toolbar and click Flow People. Students that 
are flown into the book will have a gray 
overlay, with students not flown yet in full color.
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PEOPLE PAGE TEMPLATES

There are many readily available EDOnline People Page 
templates. These can be found by selecting the Templates 
button in the left toolbar and choosing the template 
category called "People Page".

To build a template onto your page, click on the template 
you wish to use in the left sidebar, which will then highlight 
green. Then click on the page you wish to place it on -- no 
drag and drop required!

PLACING PRE-MADE TEMPLATES:

USING OUR AUTO GRID OPTION:

When you've finished filling 
out your desired information 
and dimensions, you will be 
able to see a preview of your 
Grid at the bottom of the 
sidebar.

If you cannot find a pre-made template to fit your creative 
vision, you can also use our Auto Grid feature to create a 
custom People Page Template!
The Auto Grid button is found in the left toolbar of the page 
designer.
This will allow you to choose the number of photos across and 
down to fit your desired class count. You can also customize 
where the names are placed, the shape of the photo box, 
vertical and horizontal alignment between each photo box, 
and margin width to leave room for any titles or headers. 
Once everything looks good, you can choose to place the 
template on the left or right page by selecting the 
appropriate green button at the top of the sidebar to build 
the grid on the left or right page.

You can place templates onto your pages before you upload your student portraits. Click on Design tab, then the sub-option 
Page Design in your main account dashboard. Select pages to open in the left scrollbar of the page designer. 
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PEOPLE PAGE TEMPLATES TAGGING YOUR FRAMES
EDOnline is not limited to pre-made templates and automated grid designs. You can also use our TAGGING system to 
create your perfect template for people page portraits flow. 

When tagging frames, please remember that they will be tagged in numerical order. For example, 
the first photo box will be tagged PHOTO_1 and the second box will be tagged PHOTO_2, etc. This 
way, the photos will be flowed in the order you choose. The name tags should also match the 
number of the corresponding photo box.

PROPER TAGGING:

Photo ...............................................
Teacher Photo ..............................
Name ................................................
Teacher Name ...............................
Custom Info ..................................
Header ...........................................

PHOTO_#
TPHOTO_#

NAME_#
TNAME_#

CUSTOM_#
HEADER_#

You have the ability to tag 
specific frames in order to 
allow for People Portraits and 
data to be flowed onto 
those pages. 

These tags can be found in the Advanced Settings Menu. Select a portrait or text frame on the page. Double click on the 
Frame Setting Tab and expand the second section Frame Size and Location.  The setting Tag in this menu is where you will 
type the appropriate code to have the portrait, name, or custom field flow into your custom template.

Select a frame to view the 
applicable frame settings.

Frame Settings Tab
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EDITING PEOPLE INFO
How to Edit Placed People Pages
Need to edit People Style Details, such as font? Navigate to one of your 
people pages in your book and click on either a photo frame or name 
which will prompt your Quick Menu to appear. 

Select People Styles from the Quick Menu. In the popup window that 
appears, you can change the Font, Size, Color, and Alignment and 
choose Apply to: Everyone in this group or Everyone in this book. 

After making the appropriate changes, click the green button 
that reads Save People Style to update your data.

If you would prefer to make changes to a single person on your page, select 
their photo or name and click Edit Person from the Quick Menu. 

Update their name, photo or other information and click Save Text Style or Save 
People Data to confirm your changes. 

How to Add or Delete People

Select the Manage tab and choose Manage People Data from your 
main account dashboard. To add a new person to your People Data, 
select the Add New Person button on the right side of the Manage 
People Data Window. 

Type in the appropriate fields such as First Name, Last 
Name, Grade, Teacher, etc. Click the grey Select 
Photo button and locate the photo file you'd like to 
use. Save using the blue button to finish adding a 
new person. Your pages will automatically be 
reflown after you save your content. Tip: Make sure 
you have enough frames on your pages! 

To delete people from your People Data, locate them within 
Manage People Data, click on the square to the left of their name 
and click the Delete Selected button.
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EDITING PEOPLE INFO FLOWING TWO CLASSES

To start, use the Auto Grid feature located on the left hand side of the designer to create the first section of your people page flow.

After the auto grid generates, adjust the grid to fit the correct number of students you would like to flow in one of the 
classes on that page. 

Next, click on the Layers 
button and select the Create 
Layer option. You’ll want to 
name your new layer, we 
recommend something similar 
to “People Page Pt. 2.“

Then, use the Auto Grid 
function again to generate a 
second section of students. 

Tip: Make sure that both auto 
grids start with “NAME 1”. 

Use the Multi-Select cursor tool from the right-click menu to select the second 
section of auto grid frames. Once the frames are all selected, right click for the 
right click menu again, choose Move to Layer, then choose your newly created 
layer. 

After the frames are moved to the new layer, 
Save your page and you are ready to Flow 
the two classes.

 When you then flow your people, select the 
group you’d like to flow and once you click 
on the Flow on Page button, there will be an 
extra step to confirm which template layer 
the group should flow into.

How to Flow Two Groups on One Page
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SPECIAL
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Part 4



Personalized Pages
To allow personalized pages, you must first have the upgrade added to your account by your Sales Rep or Account Manager. 

Once the upgrade has been applied to your account, navigate to the Manage tab in your main account 
dashboard and select Manage Ad Sales from the drop-down menu.

This will then open the Ad Sales homepage, where you can click on Setup Ad Pricing to turn on the 
personalized pages, along with any Ad sales you would like to make available for parents to design 
for the yearbook.

Click  on 
Setup Ad 
Pricing
to activate
Personalized 
Pages

You will then have to make sure to Activate the ad sales by changing the drop-down menu from "NO Yearbook Ad 
Sales" to "YES- you would like to turn on the ad sales".

* Keep in mind that once activate "personalized pages", parents will have to purchase a book in order to create the 
personalized page. This way the book purchase will associate with the correct personalized pages. 

If the parent has more than one child, they will need to make separate purchases in order to have a personalized page 
for each child's book.

Scan this QR Code 
to watch our How to 
Set Up and Approve 
Personalized Pages 
video.
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To allow personalized pages, you must first have the upgrade added to your account by your Sales Rep or Account Manager. 

Special Upgrades

Once ad sales are open, you should Enable the sales for the 2 personalized pages. When the parent creates their personalized 
pages, it will be a full 2 page spread every time. 

Make sure Personal 2 Page Spread is the name of the Ad Type you enable! You can then set up the cost and 
how much you are going to charge for the personalization.

Next, you will have to choose the place in the 
yearbook you would like for the personalized 
pages to go.

Choose Placeholder in order to add a blank set of 
pages to your book. If parents do not purchase 
personalized pages, the placeholder blank pages 
will print in their stead. 

Once the settings are saved, you can 
then go to Manage LINK, where you can 
copy the URL and send to the parents 
to purchase and design their 
personalized pages.

You will be able to confirm and edit the personalized pages, if necessary, before you submit your book for production. You 
will not have to place them individually in your book, as they will be added automatically in the designated placeholder spot 
once the book is printed for the individual families. 

Scan this QR Code to 
watch our How to 
Design Personalized 
Pages video from the 
parent perspective.
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DYNAMIC COVER

To allow the sale/use of Dynamic Covers, you must first have the 
upgrade added to your account by your Sales Rep or Account 
Manager.

You will also need the PSPA index file supplied by your school's 
photographer loaded into your People Page Manager before 
setting up the sales portion. See page 46 for more info on how to 
load your index file.

The Dynamic Cover Upgrade allows the purchaser to have the 
recipient's name and portrait on the front cover of the book, as 
seen here.

TURNING ON DYNAMIC COVER SALES

Once the upgrade has been added to your account and you have uploaded 
the index file, navigate to Manage > Manage Yearbook Sales to turn the sale 
of the dynamic covers on.

Scroll down to the upgrades section of the form and check off Enable 
Personalized Cover Upgrade, complete the form and hit save.

PURCHASING A DYNAMIC COVER

In order to purchase a dynamic cover, 
the purchaser must go through the 
LINK website. The cost to the purchaser 
is an additional $6.00 per book.

The purchaser will be required to 
select their child's name from the 
drop down menu seen left.

For more on the LINK site, visit pg 42.

Select  Set Up Online 
Sales to proceed.
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Setting Up Dynamic Cover

SETTING UP YOUR DYNAMIC COVER

To create and design the dynamic cover, open the cover designer from Design > 
Design Cover.  Select the Manage Covers button on the left hand side of the screen 
to create a new cover.

Click
Create Cover as 

seen left

Make sure to select 
D y n a m i c - F l o w  
Dynamic Data as 
the cover style. 

Once created, click the Design button to begin creating the 
dynamic version of your cover.

DESIGNING YOUR DYNAMIC COVER

It is recommended that you first save your original cover as a template so you can easily duplicate it for your dynamic 
cover. Learn how to save a custom template on pg 34.

Once inserted, right click on each item and select the Properties option to bring up the 
window to tag the frames.

Change the drop down menu to COVER 
NAME and position '1' for the text box and 
hit Update.

Change the drop down menu to COVER 
PHOTO and position '1' for the photo box 
and hit Update.

Once the cover design is ready, you will need to insert a blank photo 
and text box so you can link it to the data. Refer to page 29 & 31 on 
how to insert photos and text.
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DYNAMIC COVER

Once your photo and name boxes are tagged properly, you should see a 
preview of the photos and names of the dynamic covers purchased so far. 
You can toggle between portraits and names using the 'Next' and 'Previous' 
buttons, seen right.

DESIGNING YOUR DYNAMIC COVER, CONT.

To edit the font and color of the name, click the 'Edit Text 
Style' button in the same window.

This will bring up a window to edit 
the name field, pictured left. You 
can customize the look of the name 
to fit your cover design. See the final 
result pictured right! 

Make sure to toggle through all the 
names after editing the text size to 
ensure longer names fit!

Don't forget to hit 'Save' in the top left of the designer once you are happy with your edits!

After your sales have closed and you are ready to approve your book project, you will have 
to approve and review the dynamic covers purchased before completing the approval 
form.

APPROVING YOUR DYNAMIC COVER

Navigate to Manage > Approve for Production 
to view the approval form and step '1. Approve 
Cover' to confirm your design.

This screen will show you a standard version of 
your cover and a dynamic version so you can 

preview and approve your 
design.

Toggle between your 
designs to ensure everything 
looks good!
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APPROVING DYNAMIC COVERS

After the cover design is approved, you will have to review the actual covers purchased and the quantities needed 
under step '6. Approve' in the form.

APPROVING YOUR DYNAMIC COVER CONT.

The screen pictured left will 
show you the quantities of 
each type of cover.
Clicking the 'View Preview' 
button will allow you to 
preview each individual 
dynamic cover. 

The preview screen 
pictured right will allow you 
to view each individuals 
photo and name to ensure 
accuracy of each cover 
purchased.

Complete the form and you're all done! 

Questions?
Reach out to your Sales or 
Account Representative 

for more info.
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MARKET YOUR

YEARBOOK

Part3

Want to know how 
to promote and market 
your yearbook at school?
Scan this QR code to 
watch a video on 
How to Design and Order 
Marketing Materials!



How to MARKET YOUR YEARBOOK
Introduction
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Market Your Yearbook
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CREATE A SALES PLAN
Book Sales Preparation
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Market Your Yearbook
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ADVERTISEMENT STRATEGIES
Pre-Sales and Promotions
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ADVERTISEMENT STRATEGIES Market Your Yearbook
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ADVERTISEMENT STRATEGIES
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ADVERTISEMENT STRATEGIES Market Your Yearbook
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BUSINESS ADS
Selling to a Business
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Market Your Yearbook
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REQUEST a PROOF BOOK
Getting a printed Proof Book before submitting for print is a great resource! You can request a copy by going to the REQUEST 
tab in the main account dashboard and click PROOF BOOK from the drop-down.

Each proof book costs 
3 design points and 
you can check to see 
how many points you 
have at the top of the 
page.  Click on the 
Add to Cart button to 
order a proof.

Please be aware of the 3 Proof Deadlines. Once a date has passed, you can no longer 
order a proof for that date.

You then can confirm how many proof books 
you would like to order. Each Proof Book costs 
3 design points.

The last step will be to fill out the shipping address 
where you would like for the proof(s) to be 
delivered.  

Once you have ordered the proof book, it will take 
one week plus shipping time for you to receive, or 
approximately 10 business days.

Getting a Proof Book is the best way to get a printed version of your book so that you can check the image quality 
and see how the pages will print when sent for production. If you do not have design points, contact your Account 
Manager or call support for more.78



REQUEST a PROOF BOOK REQUEST Marketing!
Marketing Features

Need Posters and/or Order forms to promote your yearbook? Go to the REQUEST tab from the main account dashboard and 
click Marketing Materials from the drop-down.

First you must create a 
coupon code in order to 
request marketing.

Order forms - 1 Design point gives you 4 packs ( Each pack contains 
25 order forms) for a Total of 100 Order forms per design point

Posters -  1 Design Point per 10 posters (if you order 20 posters, it will 
cost 2 design points, etc.)

Once you put in how many Posters and Order forms you need, click 
Create Coupon Code and go to the next step to start designing.

Once you click on Design, you will be taken to the designer where you will be able to design or choose a pre-designed 
template for your Poster and Order forms.  It will take 2 weeks plus shipping time to receive once you submit them. 79




